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General information

Code of conduct:

e Use welcoming and inclusive language.

e Be respectful of different viewpoints and experiences.

e Gracefully accept constructive criticism.

e Focus on what is best for the community.

e Show courtesy and respect towards other community members.
— The Carpentries Code of Conduct

Instructors and Helpers:

Instructors: Bjgrn Bartholdy, Eduard Klapwijk, Peter Verhaar, Stephanie van
de Sandt

Helpers: Halford Dace, Elviss Dvinskis, Narmin Rzayeva, Agnes Schneider

@ Getting help

Stick the red sticky to your laptop screen to indicate you need help to
continue; a helper will try to 'unblock’ you.

Green sticky notes when you are ready with the exercises

Do you need to catch up with the scripts? A helper will be documenting
the scripts in this Google document / GitHub.

—  Workshop website

https://ubvu.github.io/2024-06-20-ldev-amsterdam/



https://docs.carpentries.org/topic_folders/policies/code-of-conduct.html
https://ubvu.github.io/2024-06-20-ldev-amsterdam/

Pre-workshop survey
https://carpentries.typeform.com/to/wi32rS?slug=2024-06-20-ldev-a
msterdam

Short link to this document: https://edu.nl/3g71t

GS Credits

GS credits TUD

o PhD candidates get 1.5 GS credits if they participate in the two
days of the workshop.

e Sign in every day in the ‘Roll call’, stay for all the sessions, be
participative to receive the GS credits.

e You will receive the Course Attendance form with the instructor's
signature at the end of the workshop.

GS Credits Leiden

o PhD students will receive 18 hours of study credits.

o Masters students should contact Kristina Hettne -
k.m.hettne@library.leidenuniv.nl

e 3Sign in every day to receive the GS credits.

e You will receive the Course Attendance form with the instructor's
signature after the workshop is finished.

GS credits Erasmus University

e Erasmus Graduate School of Social Sciences and the Humanities
(EGSH) students can obtain 2.5 ECTS.

e Sign in every day in the ‘Roll call’, stay for all the sessions, be
participative to receive the GS credits.



https://carpentries.typeform.com/to/wi32rS?slug=2024-06-20-ldev-amsterdam
https://carpentries.typeform.com/to/wi32rS?slug=2024-06-20-ldev-amsterdam
https://edu.nl/3g7ft
mailto:k.m.hettne@library.leidenuniv.nl
https://www.egsh.eur.nl/doctoral-education/phd-course-guide/data-analysis-with-r/data-carpentry-for-social-sciences-and-humanities/
https://www.egsh.eur.nl/doctoral-education/phd-course-guide/data-analysis-with-r/data-carpentry-for-social-sciences-and-humanities/

e Send Eduard (e.klapwijk@essb.eur.nl) a message if you want to
receive credits, he will send your name to the EGSH office.

GS credits VU Amsterdam

e Sign in every day to receive 1 EC. We can only issue certificates to
those who participate during the whole workshop!

e For PhD candidates: After the workshop, you can request the Data
Carpentry edubadge
(https://www.edubadges.nl/public/wpj_1EV5QZapbPfDe0GsjA).
Follow the instructions to upload the edubadge in Hora Finita.

e Contact Stephanie (s.van.de.sandt@vu.nl) for questions or
support.

Short overview of the workshop

Workshop overview_Data Carpentry for social sciences


https://docs.google.com/presentation/d/1UHW8v1docLWlduDHOoaMs8tn-eiBay7aPwovk0KLito/edit?usp=sharing
mailto:e.klapwijk@essb.eur.nl
https://www.edubadges.nl/public/wpj_1EV5QZapbPfDe0GsjA
mailto:s.van.de.sandt@vu.nl

Day 2: It is full of R!

Before you leave:

Post-workshop survey

Please help us improve future editions of this workshop by completing the post-workshop
survey. Did you learn things you can and will apply in your research or work?

Link to the survey: ISR

How to continue?

Programme

9:00 - Welcome

9:10 - Starting with data (2)
10:15 - Break

10:30 - Data Wrangling
11:30 - Break

11:45 - Data Wrangling
12:30 - Lunch

13:30 - Quarto

14:25 - Break

14:35 - Data Visualization
15:50 - Break

16:05 - Data Visualization
16:50 - Wrap-up

17:00 - End

List of Participants

Meron Vermaas, VU

Moretta Damayanti Fauzi (VU)
Lisa Schelling (EUR)
Willem-Jan Gieszen (TUD)
Mélie Louys (LU)

Ying-ting Wang (LU)


https://carpentries.typeform.com/to/UgVdRQ?slug=2024-06-04-uvavu

Isadora Aubel Olivares (TUD)
Juliette Lévénez (VU)

Jorg de Jonge (TUD)
Muhammad Farooq (VU)
Hao Zhang (EUR)

Alberto Estrada (EUR)

Ibeth Lopez (EUR)

Iryna Frankova (VU)

Eszter Szedlacsek (VU)

Day 2 - Questions

You can add questions here and the helpers will be answering them ;-)

Day 2 Commands and Instructions

Live code:


https://github.com/4TUResearchData-Carpentries/workshop_notes/blob/2406-LDEV-VU/data-carpentry/scripts
https://github.com/4TUResearchData-Carpentries/workshop_notes/blob/2406-LDEV-VU/data-carpentry/scripts
https://github.com/4TUResearchData-Carpentries/workshop_notes/blob/2406-LDEV-VU/data-carpentry/scripts
https://github.com/4TUResearchData-Carpentries/workshop_notes/blob/2406-LDEV-VU/data-carpentry/scripts

PART 1 - Starting with Data in R

Direct link to starting with R code:

https://github.com/4TUResearchData-Carpentries/workshop_notes/blob/
2406-LDEV-VU/data-carpentry/scripts/start-data.R

PART 2 - Data wrangling in R
Direct link to Data Wrangling code:

https://qgithub.com/4TUResearchData-Carpentries/workshop notes/blob/
2406-LDEV-VU/data-carpentry/scripts/data-wrangling.R

In case you are interested, you can find more information about the
difference between the base pipe and the magrittr pipe on this blog

PART 3 - Introduction to Quarto

https://cforgaci.qithub.io/r-sociahtt
tmllsci/08-quarto.html

s://cforgaci.qithub.io/r-socialsci/08-quarto.h



https://github.com/4TUResearchData-Carpentries/workshop_notes/blob/2406-LDEV-VU/data-carpentry/scripts/data-viz.R
https://github.com/4TUResearchData-Carpentries/workshop_notes/blob/2406-LDEV-VU/data-carpentry/scripts/data-viz.R
https://github.com/4TUResearchData-Carpentries/workshop_notes/blob/2406-LDEV-VU/data-carpentry/scripts/data-viz.R
https://github.com/4TUResearchData-Carpentries/workshop_notes/blob/2406-LDEV-VU/data-carpentry/scripts/data-viz.R
https://github.com/4TUResearchData-Carpentries/workshop_notes/blob/2406-LDEV-VU/data-carpentry/scripts/start-data.R
https://github.com/4TUResearchData-Carpentries/workshop_notes/blob/2406-LDEV-VU/data-carpentry/scripts/start-data.R
https://github.com/4TUResearchData-Carpentries/workshop_notes/blob/2406-LDEV-VU/data-carpentry/scripts/data-wrangling.R
https://github.com/4TUResearchData-Carpentries/workshop_notes/blob/2406-LDEV-VU/data-carpentry/scripts/data-wrangling.R
https://www.tidyverse.org/blog/2023/04/base-vs-magrittr-pipe/
https://www.tidyverse.org/blog/2023/04/base-vs-magrittr-pipe/
https://datacarpentry.org/r-socialsci/04-tidyr.html#applying-what-we-learned-to-clean-our-data
https://datacarpentry.org/r-socialsci/04-tidyr.html#applying-what-we-learned-to-clean-our-data
https://cforgaci.github.io/r-socialsci/08-quarto.html
https://cforgaci.github.io/r-socialsci/08-quarto.html

Direct link to Quarto code:
https://github.com/4TUResearchData-Carpentries/workshop_notes/blob/2406-
LDEV-VU/data-carpentry/documents/awesome-report.gmd
https://github.com/4TUResearchData-Carpentries/workshop_notes/tree/2406-
LDEV-VU/data-carpentry/documents

PART 4 - Data visualisation in R

Link to crazy visualisations in R from TidyTuesday by 'z3tt":
https://github.com/z3tt/TidyTuesday

See also https://github.com/rfordatascience/tidytuesday

Direct link to Data viz code:
https://github.com/4TUResearchData-Carpentries/workshop notes/blob/

2406-LDEV-VU/data-carpentry/scripts/data-viz.R

Day 2 Feedback

Please fill in your feedback on the sticky notes: something you liked on
the yellow note and on the orange.

Day 1 - Spreadsheets, OpenRefine, R

List of Participants:

Jorg de Jonge (TUD)

Moretta Damayanti Fauzi (VU)
Mélie Louys (Leiden U)
Willem-Jan Gieszen (TUD)


https://github.com/4TUResearchData-Carpentries/workshop_notes/blob/2406-LDEV-VU/data-carpentry/documents/awesome-report.qmd
https://github.com/4TUResearchData-Carpentries/workshop_notes/blob/2406-LDEV-VU/data-carpentry/documents/awesome-report.qmd
https://github.com/4TUResearchData-Carpentries/workshop_notes/tree/2406-LDEV-VU/data-carpentry/documents
https://github.com/4TUResearchData-Carpentries/workshop_notes/tree/2406-LDEV-VU/data-carpentry/documents
https://github.com/z3tt/TidyTuesday
https://github.com/rfordatascience/tidytuesday
https://github.com/4TUResearchData-Carpentries/workshop_notes/blob/2406-LDEV-VU/data-carpentry/scripts/data-viz.R
https://github.com/4TUResearchData-Carpentries/workshop_notes/blob/2406-LDEV-VU/data-carpentry/scripts/data-viz.R
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Programme

9:00 - Welcome

9:15 - Introduction to R
10:00 - Break
10:15-Introto R

11:15 - Break

11:30 - Spreadsheets
12:30 - Lunch

13:30 - OpenRefine
14:30 - Break

14:45 - OpenRefine
15:30 - Break

15:45 - Starting with Data
16:50 - Feedback
17:00 - End

For today you need the following files:

SAFI_clean.csv
SAFI_messy.xIsx
SAFI_dates.xlsx
SAFI openrefine.csv

In a folder called data-carpentry-workshop in an easy to find and
access folder, for example within your Home folder. Please include the
dashes ‘-’ in between the words!

And the following software:


https://ndownloader.figshare.com/files/11492171
https://ndownloader.figshare.com/files/11502824
https://ndownloader.figshare.com/files/11502827
https://ndownloader.figshare.com/files/11502815

e R and RStudio:

O You need to install R before you install RStudio.
o Instructions:

m For Windows: https://datacarpentry.org/r-socialsci/#windows

m For MacOS: https://datacarpentry.ora/r-socialsci/#macos

m For Linux: https://datacarpentry.org/r-socialsci/#linux

o Please install the latest release of R studio or update it if you have

previously installed it. You need to have the version of RStudio (v2023.06).

e Spreadsheet programme (i.e. Excel, LibreOffice)
e OpenRefine: Download software from_https://openrefine.org

Day 1 Questions

You can add questions here and the helpers will be answering them ;-)
[ J
[
[

Day 1 Commands/Instructions

This section will contain all commands/actions that are done by the
instructor. You can go back here if you’re stuck or if you missed
something.

Slides: Intro to R

PART 1: Introduction to R

Live code:

10


https://datacarpentry.org/r-socialsci/#windows
https://datacarpentry.org/r-socialsci/#macos
https://datacarpentry.org/r-socialsci/#linux
https://www.libreoffice.org/download/libreoffice-fresh/
https://openrefine.org
https://bbartholdy.github.io/2024-03-14_dc-ldev_slides/intro-r.html

https://github.com/4TUResearchData-Carpentries/workshop_notes/tree/
2406-LDEV-VU

Direct link to intro to R code:
https://github.com/4TUResearchData-Carpentries/workshop notes/blob/

2406-LDEV-VU/data-carpentry/scripts/intro-to-r.R

Files: for reference, the R lesson uses SAFI|_clean.csv. The direct download link for
this file is: https://ndownloader.figshare.com/files/11492171

Why R

free and open source

created by statisticians for statistics
great for reproducibility

FREE

We will use RStudio (lots of benefits there as well)

PART 2: Data Organisation in Spreadsheets

Slides:

LDEV_spreadsheets

Exercises:

Working with Messy Data

1.

Download the dataset SAF| messy.xlIsx

2. Open the data in a spreadsheet program
3.
4

Inspect both sheets and compare how the data is structured.

Notice that there are two tabs. Two researchers conducted the interviews, one in
Mozambique and the other in Tanzania. They both structured their data tables in a
different way. Now, you’re the person in charge of this project and you want to be
able to start analysing the data.

Try to harmonise the dataset.

Post a screenshot of your result here and add what annoyed you most.

Important: Do not forget our first piece of advice, to create a new file (or tab) for the cleaned
data, never modify your original (raw) data.

INSERT SCREEN SHOTS HERE

11


https://docs.google.com/presentation/d/1h6P50dfRO_ByE4afy-drX_aEQ4lXJ0FUY6wmBotxRdQ/edit?usp=share_link
https://github.com/4TUResearchData-Carpentries/workshop_notes/tree/2406-LDEV-VU
https://github.com/4TUResearchData-Carpentries/workshop_notes/tree/2406-LDEV-VU
https://github.com/4TUResearchData-Carpentries/workshop_notes/blob/2406-LDEV-VU/data-carpentry/scripts/intro-to-r.R
https://github.com/4TUResearchData-Carpentries/workshop_notes/blob/2406-LDEV-VU/data-carpentry/scripts/intro-to-r.R
https://ndownloader.figshare.com/files/11492171
https://ndownloader.figshare.com/files/11502824

->
->
->

Importing a .csv
1. Download the clean version of the SAFI dataset: SAFI| clean.csv

2. Import the comma separated value (csv) file in your spreadsheet program
a. Open a new file

b.

~T T T@ ™Mo a0

Go to “file” ->

Home |

|

Paste

Al

|| — Mﬁﬁx

A

[

wj B Un B W

=]

File Edit WView Insert Format Tools

Mew I

Mew from Template... Bias Data

Open...

Open Recent > F A =
Close Lo =
Save

Save As...

Save as Template...

Select “CSV file” and click “import”

Select the SAFI_clean.csv file from your file system
Press “get data”

Get through the text wizard and select “delimited”
Select “comma” as delimiters

Click “next” and use the “general” column data format

Click “finish”

Keep the “table” selected for “how do you want to view this data?”

Click “Import”

“import”

12


https://ndownloader.figshare.com/files/11492171

Text Import Wizard - Step 2 of 3

This screen lets you set the delimiters your data contains.

Delimiters
Tab

Semicolon

Comma
Space
Other:

Preview of selected data:

Text qualifier:

Treat consecutive delimiters as one

~
v

Exercise: Data Validation

Validate the “no_membrs” column and make sure that only positive values are in there.

BN

Select the column “no_membrs”

2. Click on “Data” -> “Validation”
3. Validation criteria: allow “whole number” ; data: “between”; minimum: “1”, maximum:

“301!

4. Click “ok”
5. Try to change a value to 42

Apply a new data validation rule to one of the other categorical columns in this data table.
Discuss with the person sitting next to you what a reasonable rule would be for the column

you've selected. Be sure to create an informative input message.

key_ID fillage [interview_date ho_membrs |years_liv frespondent_wall_type frooms memb_assoc pffect_confli
i} God P016-11-17T00:00:00Z B 3 uddaub n NULL NULL
il God P016-11-17T00:00:00Z |7 p muddaub L es bnce
B God P016-11-17T00:00:00Z (10 s burntbricks il NULL NULL
3 liod P016-11-17T00:00:00Z |7 b burntbricks il NULL NULL
5 God P016-11-17T00:00:00Z |7 no burntbricks ! NULL NULL
b God P016-11-17T00:00:00Z B B uddaub n NULL NULL
7 iod P016-11-17T00:00:00Z b B8 uddaub L ho hever
B Chirodzo P016-11-16T00:00:00Z [12 70 burntbricks B ves hever
Cancel < Back Finish

13



& Excel File Edit View Insert Format Tools Data Window Help

—
. ® AutoSave (I () 73 Sort... Book
Home Insert Draw  Page Layout Formulas D guieatilten SAP Analytic
Eﬁ v & Calibri (Body) v 12 v A" A° | Advanced Filter... ral
@~ |
Paste P B I Uw S A Subtotals... % 2
D1 . fx nao_membrs
A B c D E Table... I )
1 |key_ID village interview_date no_membrs [years_liv responi_ Text to Columns... m liv_count |
2 1God  2016-11-17TH 3 4 muddai Consolidate... [ 11
3 1God  2016-11-17TH 7 9 mudda . | 3.
4 3God  2016-11-17TH 10 15| iR CUPENdiQUInE D 1:
5 4 God  2016-11-17T 7 6 burntb  Edit Links... | 21
6 5God  2016-11-17T 7 40 burntbr 4
7 6 God 2016-11-17Ti 3 3 mudda) Summarise with Pivot Table | 11
8 7God  2016-11-17T 6 38 muddal [ 11
9 8 Chiredzo 2016-11-16 12 70 burntbr [ 2,
10 9 Chiredzo 2016-11-16 8 6 burntbr [ 31
11| 10 Chirodze 2016-12-16 12 23 burntbr | 24
12|  11Ged 20161121 6 20 sunbric 5 | 2,
13| 12 Ged 20161121 7 20 burntbr | 24
14 13 God 2016-11-21 [ 8 burntbr  Get Data (Power Query) > il
15| 14 God  2016-11-21 10 20 burntbr  Refresh [ 3|
16| 15 Ged 20161121 5 30 sunbrici_ S 3l
17| 16 God  2016-11-24 6 47 muddaub 1 NULL NULL 4
12 17 G INTA-1 121 TR-NN-NNT " M cunhricke 1 NI LRI 10
Exercise: Exporting Data

1. Click on “File” -> “Save as..”

2. Select csv as file format

3. Click “save”

Save As: ( SAFI_clean_workcopyicsv ]
Tags:
Where: [ Desktop v
. . . - =
Online Locations File Format: CSV UTF-8 (Comma-delimited) (.csv)

Options...

Cancel Save

Notes:

14



PART 3: OpenRefine

Slides:
Material: Lesson material
Data: SAFI| _openrefine.csv

2024-06_OpenRefine.pptx

Documentation of instructions

A new project / import data

1. Create Project and select “Get data from This Computer”.
2. Choose the SAFI_openrefine.csv file

3. Click “Next”

W OpenRefine A power tool for working with messy data.

Create project «start over ~ Configure parsing options

Open project interview_date quest_no start

Import project il 17-Nov-16 1 2017-03-
23T09:49:57.000Z

Language settings

2. 17-Nov-16 1 2017-04-

02709:48:16.000Z

3. 17-Nov-16 3 2017-04-
02T14:35:26.000Z
4. 17-Nov-16 4 2017-04-
02T714:55:18.000Z
5. 17-Nov-16 5

2017-04-
02715:10:35.0002
Parse data as

CSV/ TSV / separator-based files
Line-based text files
Fixed-width field text files

end

2017-04-
02T17:29:08.000Z
2017-04-

02T17:26:19.000Z

2017-04-
02T17:26:53.000Z

2017-04-
02T17:27:16.000Z

2017-04-
02T17:27:35.000Z

Character encoding

province
Manica

Manica

Manica

Manica

Manica

district
Manica

Manica

Manica

Manica

Manica

Us-AsCll

Columns are separated by
« commas (CSV)

ward
Bandula

Bandula

Bandula

Bandula

Bandula

village
God

God

God

God

God

Project name SAFI openrefine csv

Tags

years_farm agr_assoc no_membrs _members_count

1 no 3 3
2 yes 7 7
40 no 10 10
6 no 7 7
18 no 7 7
Ignore first 0
« Parse next 1

Column names (comma separated)

to enclose cells containing column separators

X tabs (TSV)
? PC-Axis text files custom ,
JSON files
Version 3.8.1 [TRUNK] MARC files. v Use character "
JSON-LD files e (ol characters with |
scape special characters wil
Preferences RDF/N files
Help
About RDF/N-Triples files

Trim leading & trailing whitespace from strings

4. Check the preview of the file (s. screenshot)

5. Click “create project”

Using Facets

Text Facets

Discard initial 0
Load at most 0

1. Click on the small arrow next to the variable “village”

line(s) at beginning of file

line(s) as column headers

Create project »

remittance_money years_liv parents_liv sp_parents_|

no 4 no yes
no 9 yes yes
no 15 no no
no 6 no no
no 40 yes no

Update preview
Disable auto preview

Attempt to parse cell
text into numbers

v Store blank rows

v Store blank cells as nulls
Store file source
Store archive file

row(s) of data
row(s) of data

15


https://docs.google.com/presentation/d/1hwdOcsHQAU9f37-o0aHEBu8gd7jUB3tQ/edit?usp=sharing&ouid=109113863822045406787&rtpof=true&sd=true
https://datacarpentry.org/openrefine-socialsci/index.html
https://ndownloader.figshare.com/files/11502815
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¥ ward | ¥ village ¥ years_farm ¥ agr_assoc ¥ no_membrs

Text facet
Numeric facet
Timeline facet

Scatterplot facet...

Custom text facet...

Custom numeric facet...

Customized facets

Bandula Facet »
Text filter

Bandula Edit cells »
Edit column »
Transpose »
Sort...

Bandula View »
Reconcile »

Bandula  God 6

2.

ho 7

3. Do you see any problems with the data?
4. Hover the mouse over one of the names in the Facet list. You should see that you
have an edit function available.

Clustering

1. In the village text facet click on “cluster”
2. Select method -> key collision and key function -> metaphone3

Cluster and edit column "village"

Find groups of different cell values that might be other representations of the same thing. For example, "New York" and "new york" likely refer to the same concept and

just differ by capitalization, and "Gédel" and "Godel" probably refer to the same person. Find out more...

Method Key collision ) Keying function Metaphone3

Cluster size Row count Values in cluster

Merge? New cell value

2 45 ¢ Ruaca
¢ Ruca
2 4 ¢ Ruaca-Nhamuenda

¢ Ruaca - Nhamuenda

Select all | Deselect all

Ruaca

Ruaca-Nhamuenda

Auto-update 2 clusters found

# Rows in cluster

4—145

Average length of choices

4—16

Length variance of choices

0.5—1

Export clusters Merge selected & re-cluster Merge selected & Close = Close

1. Click the Merge? box beside each cluster, then click Merge Selected and Recluster
to apply the corrections to the dataset.

2. Close the window

16



3. Clean the misspelt words “Chirdozo” manually with the edit button in the facet

window.

4. Change Ruaca-Nhamuenda to “Ruaca”

Facet/Filter = Undo/Redo3/3 <
Refresh Reset all Remove all
village change

6 choices Sort by: name count Cluster
49
Chirdozo edit include
Chirodzo
God
Ruaca

Ruaca-Nhamuenda

Facet by choice counts

Transforming Data

131 rows
Show as: rows records S
v Al ¥ | interview_date
1.  2016-11- 1
17T00:00:00Z
Chirdozo
Apply = Cancel
3. 2016-11- 3
17T00:00:00Z

Anan a4 a

1. Click the down arrow at the top of the items_owned column. Choose Edit Cells >

Transform...
2. First we will remove all of the
value.replace("[", ") and click

left square brackets ([). In the Expression box type
OK.

' Custom text transform on column items_owned

Expression

pms_owned_ot|
Language General Refine Expression Language (GREL) |

value.replace("[", "")

Preview History Starred Help

row value
1. [bicycle'; 'television'; 'solar_panel'; 'table’]

2. [cow_cart'; 'bicycle'; 'radio'; 'cow_plough';
'solar_panel'; 'solar_torch'; 'table'; 'mobile_phone']

3.  ['solar_torch'

4.  [bicycle'; 'radio’; 'cow_plough'; 'solar_panel';
'mobile_phone']

5. ['motorcyle’ ; 'radio’; ‘cow_plough'; 'mobile_phone']

value.replace("[", "")
‘bicycle' ; 'television'; 'solar_panel'; 'table']

‘cow_cart'; 'bicycle'; 'radio’; 'cow_plough';
'solar_panel'; 'solar_torch'; 'table'; 'mobile_phone'

'solar_torch']

‘bicycle' ; 'radio'; 'cow_plough'; 'solar_panel';
'mobile_phone']

'motorcyle’ ; 'radio' ; 'cow_plough'; 'mobile_phone']

On error © keep original Re-transform up to 10 times until no change
set to blank
store error
OK Cancel
'aoats'l “bicvcle'J:
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Exercise:
Exercise: Remove unwanted characters (3 min)

Use this same strategy to remove the single quote marks ('), the right
square brackets (]), and spaces from the items_owned column.

Which two items are the most commonly owned? Which are the two least commonly owned?

1. Click the down arrow at the top of the items_owned column. Choose Facet > Custom

text facet...
2. In the Expression box, type value.split(";").
3. Sort by count

items_owned change
18 choices Sort by: name count
mobile_phone
radio
cow_plough
solar_panel
bicycle
solar_torch
table
motorcyle
television
cow_cart

sterio
NLILL

Undo / Redo Changes

1. Click on the Undo / Redo button
2. Restore a version where items_owned was still in square brackets

Filtering

1. Click the down arrow next to respondent_roof _type > Text filter. A
respondent_roof type facet will appear on the left margin.
2. Type mabat
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https://datacarpentry.org/openrefine-socialsci/instructor/02-working-with-openrefine.html#remove-unwanted-characters

Facet/Filter ~ Undo/Redo5/9
Refresh Reset all Remove all

respondent_roof_type invert reset

mabat

case sensitive regular expression

Sort

Show as: rows records

< 58 matching rows (131 total)

Show: 5 10 25 50 100 500 1000 rows

mbers_count | remittance_money ¥ years_liv v parents_liv ¥ sp_parents_liv ¥ grand_liv ¥ sp_grand_liv ¥ respondent_roof_type

15 no no
6 no no
70 yes yes

no

no

mabatisloping b
mabatisloping b
mabatisloping b

Sort the data by gps_Altitude. Do you think the first few entries may have incorrect altitudes?

Click on sort

hoonh =

Numeric Facet

By default, the type of each cell is text. You can change the type by clicking on edit cells,
common transforms -> to number.

Click on the arrow button next to gps_Altitude

Sort cell values as numbers
The option sort has now an option to remove the sort

1 ¥ years_liv ¥ parents_liv ¥ sp_parents_liv ¥ grand_liv ¥ sp_grand_liv ¥ respondent_roof type ¥

Facet » yes no yes grass
Text filter
Edit cells »  Transform... yes grass
Edit column »  Common transforms »  Trim leading and trailing whitespace
Transpose 4 Fill down Collapse consecutive whitespace
Sort... Blank down Unescape HTML entities
View 4 Split multi-valued cells... Replace smart quotes with ASCII
Reconcile » | Join multi-valued cells... To titlecase

6 no

Cluster and edit...

To lowercase

Replace...
40 yes no
3 no no
38 yes no

Y€s To number
To date

To text

no

To null

To empty string

yes

To uppercase

You cannot change a number to “abc” for example

m
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Exercise:Transforming column contents to numbers (3 min)

Transform three columns:
No_membrs

years_liv

and buildings_in_compound

from text to numbers. Can all columns be transformed to numbers? - Try it with village for

example.

Saving your work as a script

1.

In the Undo / Redo section, click Extract..., and select the steps that you want to

apply to other datasets by clicking the check boxes.

Extract Operation History

Extract and save parts of your oparation history as JSON that you can apply to this or other projects in the future.

ey

Taxt transfarm on calls in column liv_owned using expres
sion grel-value.replaca("[", ).replace("]", *").replaca(" ",
“*).replace(™, **)

Taxt transform on calls in column months_na_water usin
g expression gral:value replace("[", **).raplaca("]", “).repl
ace(" *, "")replace(™, ")

Taxt transform on calls in column respandent_wall_type_
athar using exprassion value. trim()

Mowve column villaga to position 61
Move column village to position 0
Mass edit cells in column village

Text transform on cells in column years_farm using expre
ssion value.toNumber()

Text transform on cells in column no_membrs using expr
ession value. ioNumben()

Text transform on cells in column bulldings_in_compoun
d using expression value.toMumber])

Text transform on cells in column years_liv using express
ion value toNumber()

Select All | Unselect All

Close

1

e

“op"i "core/text-transform”,
“description”: "Text transform on cells in eolumn |
“engineConfig”s {

“mode”: “row-based”,

“facets™: [1
“columnRame”: “interview_date®,
“expression”: “"walue.toDate|)”,
“onError”: “keep-original”®,

“repeat”: false,
“repeatCount”y 10

“op": "core/mass-edic”,
“description”: "Hass edit cells in column village®,
“englneConiig”s {

"mode”: "row-based”,

“facats®: []

.
“colunnfame”: “"willage"®,
“expression”: “walue®,
“edits®s [

i
“fromBlank”: false,
“fromError”: false,
“from®: [
*RusSA ",
*Ruca”
Ie
"te": "Ruaca”
b
“fromBlank”: false,

“fromError”: falee,
"Eromts

Exporting Cleaned Data

1.

OpenRefine creates a file whose name is based on the project name and asks the

Click Export in the top right and select the file type you want to export the data

in. Tab-separated values (tsv) or Comma-separated values (csv) would be

good choices.

browser to download it. Depending on your browser settings, this file is automatically
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saved in the default location for downloaded files, or you see a dialog window to
choose where you want to save the file.

Useful Links:

OpenRefine has its own web site with documentation and a book:

OpenRefine web site
OpenRefine User Manual
Using OpenRefine book by Ruben Verborgh, Max De Wilde and Aniket
Sawant
e OpenRefine history from Wikipedia

In addition, see these other useful resources:

e Grateful Data is a fun site with many resources devoted to OpenRefine,
including a nice tutorial.

e OpenRefine source code on GitHub
Fora: official forum, StackOverflow

PART 4: Starting with data in R

Live code:
https://github.com/4TUResearchData-Carpentries/workshop _notes/tree/
2406-LDEV-VU

- Lesson material and slides

Direct link to starting with R code:
https://github.com/4TUResearchData-Carpentries/workshop notes/blob/

2406-LDEV-VU/data-carpentry/scripts/start-data.R

Day 1 Feedback

Please fill in your feedback on the sticky notes: something you liked on
the green note and something that could be improved on the pink.
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https://openrefine.org/
https://openrefine.org/docs
https://www.worldcat.org/title/using-openrefine-the-essential-openrefine-guide-that-takes-you-from-data-analysis-and-error-fixing-to-linking-your-dataset-to-the-web/oclc/889271264
https://en.wikipedia.org/wiki/OpenRefine
https://github.com/scottythered/gratefuldata/wiki
https://github.com/OpenRefine/OpenRefine
https://forum.openrefine.org/
https://stackoverflow.com/questions/tagged/openrefine
https://datacarpentry.org/r-socialsci/02-starting-with-data.html
https://docs.google.com/presentation/d/1-cd-EsupPQ4uQqCH48B1f6BR8bQlo6Ph/edit?usp=sharing&ouid=116835254449858754835&rtpof=true&sd=true
https://github.com/4TUResearchData-Carpentries/workshop_notes/blob/2406-LDEV-VU/data-carpentry/scripts/start-data.R
https://github.com/4TUResearchData-Carpentries/workshop_notes/blob/2406-LDEV-VU/data-carpentry/scripts/start-data.R
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How to continue with R, research data and
research software?

You can join several communities to keep on learning!

Leiden Open Science Community / Research Software Community Leiden

Delft Open Science Community

Open Science Community Rotterdam
EUR Dat ffee Break

R café at TU Delft

R-Ladies Global

VU Data Conversation Research Software
VU coding café Bytes & Bites

You can join other training and workshops at Leiden, TU Delft, VU and EUR:

Workshops/Training at the Centre for Digital Scholarship Leiden

Training at TU Delft

Training at VU

Data Analysis with R at the Erasmus Graduate School for Social Sciences
and Humanities

Code Refinery: intermediate- and advanced level courses on code skills
Taxila: Dutch national platform that is the one stop shop for training on
research data, research software, open science, and the like.

Some online resources for self-study:

Quarto guidelines: https://quarto.org/

R for Data Science by Hadley Wickham (online book with exercises)
Data Visualization by Kieran Healy (online book with code examples)

R Graph Gallery for choosing visualization with tidyverse & ggplot2 (incl.
reproducible code)

Color in R names and hexcode of colors in R

Learning Statistics with R - online book on basics of R and running statistics in

R

Exploratory Data Analysis in R how to explore your data set
R for graduate students Data wrangling and plotting in R

R for Non-Programmers: A Guide for Social Scientists resource for beginners
Big Book of R “your last-ever bookmark”; a compilation of loads of resources!

Applied Statistics with R
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https://www.universiteitleiden.nl/open-science-community-leiden
https://researchsoftware.pubpub.org/
https://osc-delft.github.io/
https://www.openscience-rotterdam.com/home/
https://eur-nl.github.io/data-coffee-breaks/
https://delft-rcafe.github.io/home/Index.html
https://rladies.org
https://vu-nl.libcal.com/calendar/universitylibrary/software
https://ubvu.github.io/bytes-and-bites/
https://www.library.universiteitleiden.nl/about-us/centre-for-digital-scholarship/workshops
https://www.tudelft.nl/en/library/research-data-management/r/training-events/training-for-researchers
https://staging.taxila.nl/content_providers/vu-amsterdam
https://www.egsh.eur.nl/doctoral-education/phd-course-guide/data-analysis-with-r/
https://coderefinery.org/
https://taxila.nl/
https://quarto.org/
https://r4ds.hadley.nz/
https://socviz.co/
https://r-graph-gallery.com
https://r-charts.com/colors/
https://bookdown.org/ekothe/navarro26/preface.html
https://bookdown.org/rdpeng/exdata/
https://bookdown.org/yih_huynh/Guide-to-R-Book/
https://bookdown.org/daniel_dauber_io/r4np_book/
https://www.bigbookofr.com
https://book.stat420.org/

Post-workshop survey

Please help us improve future editions of this workshop by completing the post-workshop
survey. Did you learn things you can and will apply in your research or work?

Link to the survey: Post-workshop Survey
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https://carpentries.typeform.com/to/UgVdRQ?slug=2024-06-04-uvavu

